SimaPro 7.3.3 database update instructions from
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1 Update of the database
This document describes how to update your database with new and updated data. This update will change
the results of your calculations. For example, importing ecoinvent v2.2 will replace the ecoinvent v2.1 data
and thus update all your models that use ecoinvent v2.1 data.
Importing a database is memory and processor intensive, so we recommend setting aside 2 to 3 hours and
limiting the number of other programs running on the computer (also in the background). The computer on
which the update is performed should meet the system requirements: www.presustainability.com/content/system-requirements. On slower computers or computers with limited free RAM
memory the update can take a very long time or crash altogether. A backup of your database is made during
the import procedure. You can use this copy of the database to compare the results between the old and new
version of the database.
The update process is a sequence of three groups of actions, which are described in detail further on in this
document:
1) You first install the Full SimaPro 7.1.8-7.3.3 update database that contains the new data and
methods.
2) Then you import this database into your SimaPro database(s).
3) Finally, after finishing the import, you run an Append action (in the Substances screen) to replace
synonyms in the substance list.

1.1.1 Updating from SimaPro 7.1.8 or older
Please start with the Appendix: Chapter 3: Updating from SimaPro 7.1.8

1.1.2 Multi-User version:
Updating the database will be quicker if you do the update locally on your own PC. Make sure no users are
logged in, close the SimaPro Database Server and then move or copy the database (77 numbered *.nx1 files:
from ***00.nx1 to ***76.nx1) to your local hard drive (see 1.2 for the location of the database). In the “Open
SimaPro Database” window, choose “Local server”, browse to the database location and follow the
instructions below.
Owners of a Classroom license can request a temporary Single User license via support@presustainability.com to do the update locally.

1.2 Installation of the Full SimaPro 7.1.8-7.3.3 update database
1) After downloading the “Full update database” (SetupFullUpdateDatabase718_733.exe) from
www.pre-sustainability.com/versioncheck/, run the program and follow the instructions in the setup
wizard to store the update database on your computer.
2) You still have to import the update database into your own database(s) and perform an append!
The “FullUpdate718_733” database is installed by default in the folder which contains the database you used
last. Alternatively it can be installed in a folder of your choice or one of the following default directories:



Windows Vista, Windows 7, Windows 2008 Server:
C:\Users\Public\Documents\SimaPro\Database\
Windows XP, Windows 2003 Server:
C:\Documents and Settings\All Users\Shared Documents\SimaPro\Database\

Multi-User version: the update database does not need to be installed in one of the locations (directory aliases)
defined in the SimaPro database server. You can install locally.

1.3 Import of the Full SimaPro 7.1.8-7.3.3 update database
Follow these steps to import the new data:
1) If SimaPro is closed: Start SimaPro
2) Use “Open SimaPro Database” under File to open the database you want to update (the database you
usually work in).
Multi-User version: Start SimaPro 7.3.3 Multi-User and login as Manager. As the database will be locked during
import, no other users may be logged in at this moment. Continue as above.

Once you opened your database, in the File menu, select “Import SimaPro Database” and select the
“FullUpdate718_733” database from the list and click the Open button. If you do not see it, browse to
one of the default installation locations (see 1.2) or the location where you installed it.
3) Click the “Select all” button in the bottom left of the window. Click on the “Import” button.
4) The data are scanned and an overview is generated of all the data that are added or replaced. We
recommend that you save this overview. Remember that any changes you made in the libraries (e.g.
ecoinvent) or in the original methods will be lost when the data are replaced. Data sheets you added
will still be there.
5) Click OK to start the import process. When you import ecoinvent libraries, SimaPro asks you to verify
the replacement of each process when updating existing libraries. Click on the “Yes to all” button to
accept all replacements.
6) After final confirmation, a backup will be made of the database. The actual import will start. A
message will appear once the import is successfully completed. Note that this process can take
considerable time.
There still is one more step required to complete the update!
7) Go to the “Substances” section under “General Data” in the LCA explorer screen (home). Click on the
“Append” button. A new window will open. Click the “Load” button on the right hand side and select
the append file “AppendSubstances733.xls”. The AppendSubstances733.xls file is found in the
SimaPro database directory (see 1.2 for default locations). You can ignore the message “Some lines
are not read. Do you want to see the errors?” by clicking No.

8) Now click the OK button on the bottom of the window. After final confirmation the substance list will
be appended. Depending on the size of your database this may take some time.
9) After finishing the Append action, you may want to create a backup of the updated database via File>
Database Management> Backup/Restore> Backup.
10) Repeat this for all other SimaPro databases you want to update (please check if they need the most
recent or the full update).
11) When finished, you can delete the “FullUpdate718_733” database.
12) To use the new libraries in your projects, go to “Libraries” in the “Goal and Scope” sections and check
the libraries that you want to use.

2 Making backups
You probably know that PCs, laptops and even network servers crash, get stolen, fall, get coffee spilled over
them, or become infected with a virus. You also know that your colleagues or your neighbour’s children may
accidentally delete a project or perhaps a database file. You also know that neither you, nor your own
children, will ever do these kind of things. And we at PRé Consultants know that although we succeeded in
creating a very stable system, there still remains a very small chance that a SimaPro database will crash
beyond repair.
Murphy’s Law dictates there is a minor chance that such a problem will occur to you. But if it does happen, it
will typically be just before an important deadline or just after you have spent a full week of entering data
into SimaPro.
Even though this sounds dramatic, in fact it could be a relatively small problem. You simply get a new
computer, reinstall SimaPro, and restore your latest backup so ideally you only lose a day’s work. If only you
made that backup yesterday…
Thus: do make regular backups. The backup should not be located on your own PC, but on a CD or a server
drive for example. If your server is centrally backed up every night, make sure all the SimaPro database files
are included, that the SimaPro database is not in use, and that it is indeed possible to retrieve the database
from the backup file.
So, start now with making a backup of your database. You can use the backup function in SimaPro, under File,
Database Management in the menu. And remember to make the next backup soon!
If you make central backups, this information will be useful:
 When you make a backup, SimaPro must be closed and no users can be logged in the multi-user
version.
 A SimaPro 7.3 database consists of 77 numbered *.nx1 files, in the format DatabaseName00.nx1 to
DatabaseName76.nx1.
 All files must be saved at the same time, as they are interconnected.
 The default location of SimaPro databases is:
o
o

Windows Vista, Windows 7, Windows 2008 Server:
C:\Users\Public\Documents\SimaPro\Database\
Windows XP, Windows 2003 Server:
C:\Documents and Settings\All Users\Shared Documents\SimaPro\Database\

Needless to say: we sincerely hope you never need your backup!

3 Appendix: updating from SimaPro 7.1 or older
Based on SimaPro 7 Technical Note 8, March 2011

3.1 Introduction
This document describes how to update your current SimaPro 7.1 to version 7.3. You will find detailed
instructions below. Nevertheless, if you do have any questions, please contact your local SimaPro partner
(www.pre-sustainability.com/partners) or the PRé helpdesk; support@pre-sustainability.com, or +31 33
4504010.
NOTE: To update to SimaPro 7.3.3 from an older SimaPro version (SimaPro 5 or 6), use the full SimaPro
7.3.3 installation file which is available on www.pre-sustainability.com/install please contact support@presustainability.com for instructions to convert the database.

3.1.1 New registration and activation system
In SimaPro 7.2 we implemented a new registration and activation system to better protect SimaPro against
illegal use. The SimaPro 7.1 registration names and codes do not work with this update any more. You have
received a new registration name and code via e-mail. Please save the e-mail so that you have a backup of
your registration name and code, as it needs to be copied and pasted. If you did not receive an e-mail, please
check your spam filter (and white list the pre-sustainability.com domain) first before contacting us.
Activation rules
As is and was specified in the SimaPro license agreement, you are allowed one installation per user license.
The new activation system will check this and allow only one installation per user license.
If you have installed SimaPro more often than the number of users allowed, you need to uninstall the
additional licenses and carefully select the computer(s) on which you want to update. If you need to move
SimaPro to another computer, the license must first be deactivated by uninstalling the software (via
Settings/Control Panel/Add or Remove Programs) while the computer is connected to the internet.
Note that activation is not needed for the educational Classroom and Faculty licenses.

3.1.2 Summary of the update procedure
The update procedure can be summarized as follows:
1) Update of the SimaPro 7 software
Update your SimaPro 7.1 software to release SimaPro 7.3.3. You can choose not to overwrite the
SimaPro 7.1 installation. For the Multi-User version, the server also needs to be updated.
2) Conversion of SimaPro 7.1 database to 7.3.3 format
After conversion, your SimaPro database cannot be opened with previous SimaPro 7.1 versions.
3) Update of the libraries
Update your reference data by importing the update database.

3.2 Update of the SimaPro 7 software
The update to SimaPro 7.3.3 replaces your current SimaPro 7.1 software. To install the update you must have
the new SimaPro 7.3.3 registration name and code available to copy and paste into the registration fields.
Multi-User versions
We recommend that Multi-User updates are done by your network administrator. Note that both the SimaPro
client and database server need to be updated!

3.2.1 Procedure for Single User and Multi-User client
If you have a Multi-User version, first do the SimaPro database server update (see 3.2.2)!

1) Close SimaPro
2) After downloading the “SimaPro 7.3.3 installer” (SetupSimaPro733.exe) from www.presustainability.com/versioncheck/, run the program and follow the instructions in the setup wizard.
3) After installing the update, you can start SimaPro 7.3. On opening a database, the technical database
format is changed. Your SimaPro database cannot be opened with SimaPro 7.2.2 or older versions
anymore.
4) Proceed with the database update (next paragraph).

3.2.2 Procedure for SimaPro database server
Detailed instructions for installing the SimaPro 7.3.3 Database Server are found in the SimaPro installation
manual.
1) Make sure no users are logged in and close the SimaPro Database Server. If you run the database
server as a service, unload the service with the shortcut “NxServer uninstall service”. By default, this
is located in the directory “C:\Program Files\SimaPro 7.1 Database Server\”
2) During the update, the settings of your current SimaPro Database Server are copied to the new
server. The old server will be uninstalled (but data preserved) if you accept the default installation
path for the new SimaPro 7.3.3 Database server.
3) After downloading the “SimaPro 7.3.3 Database server update” (SetupServer733.exe) from
www.pre-sustainability.com/versioncheck/, run the program and then follow the instructions in the
setup wizard.

3.3 Technical conversion of the database
As SimaPro 7.3.3 uses a new technical database format, your databases need to be converted to that new
format so that SimaPro 7.3.3 can use them. This is a technical conversion only; your data will not change.
SimaPro 7.0 and 7.1 databases are automatically converted to SimaPro 7.3.3 format on opening the database
with SimaPro 7.3. Conversion can take considerable time, depending on the size of the database and the
speed of your computer.
During conversion, a copy of the database in the original 7.1 format with the extension “_version71” behind
the database name is made in the same directory. This serves as a database backup.
After conversion, the converted database cannot be opened with versions prior to SimaPro 7.2.2 anymore. If
you need the original database again, you can open the renamed copy of the database with the
corresponding previous version of SimaPro.

3.3.1 Error checks
During conversion, SimaPro makes several database checks.
1) If SimaPro tells you there are problems in the database, please save the error report.
2) In this case, please run a database check (File, Database management, Check) and
3) Send the results of the check together with the error report to the helpdesk using the E-mail
Helpdesk option in the Help menu.

3.3.2 Multi-User version (professional licenses only):
Conversion of the database will be quicker if you do the conversion locally on your own PC. Make sure no one
is logged in, close the SimaPro Database Server and then move or copy the database (77 numbered *.nx1
files) to your local hard drive. In the Open SimaPro Database window, choose “Local server” and browse to
the database location. After conversion, the database update is also quicker when done locally. Owners of a
Classroom license can request a temporary Single User license via support@pre-sustainability.com to do the
conversion and update locally.

3.4 Updating the database to include all updated and new data
After the technical conversion of the database you still need to import the new data into your database!
See chapter 1 for updating your database with the Full SimaPro 7.1.8-7.3.3 database updates.

